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You already know that you can create a
project note for any paragraph in SpecLink,
a feature that is especially useful in office
master projects. But what if you want to
attach a multi-page document or one that
has embedded illustrations? Did you know
that SpecLink lets you create hyperlinks to
separate Word documents?

To create these hyperlinks, the first thing
you need to do is to establish the root
directory path for all Word  documents that
will be hyperlinked to SpecLink. Typically,
this path would be a folder on the network
drive where SpecLink is installed. If several

SpecLink Makes LEED Specs EasierSpecLink Makes LEED Specs EasierSpecLink Makes LEED Specs EasierSpecLink Makes LEED Specs EasierSpecLink Makes LEED Specs Easier
Producing specifications to address LEED™-NC Certification just got a lot easier with
SpecLink’s two new sections that automatically activate LEED provisions in other sections:

• 01 3514 (01354) - LEED CREDIT SUMMARY — for documenting decisions as to how to
address each LEED credit.

• 01 3515 (01355) - LEED REQUIREMENTS —  for the Contractor’s information.
The LEED CREDIT SUMMARY is used to document the project team’s intentions in regard
to LEED-NC certification and particular credits.  For each credit, a status of “Required,”
“Preferred,” or “Not Required” may be set, as a record of intentions.  Following the state-
ment of each credit is a brief description of pre-defined possible solutions, taken from the
LEED Rating System itself, each linked to the specification sections which address the
credit.  When one of the pre-defined solutions is selected, the appropriate specification
section is highlighted in the Project Tree and the LEED-related provisions in that section are
activated by links.  For instance, if your project team has committed to using only “certified”
wood, you can select any or all of the Division 6 carpentry sections as solutions to MR
Credit 7.  When you do, the requirement for certified wood (which SpecLink refers to as
“sustainably harvested wood”) is activated in each selected section along with its LEED
Report submittal option.  In addition, the basic specification provisions and submittal
requirements for sustainably harvested wood are activated In Section 01600 Product
Requirements.  Similar provisions are activated for each pre-defined solution that involves
the specifications.

For further coordination, the specification sections that have been activated are also listed
in Section 01 3515 (01355) - LEED REQUIREMENTS.  This section is a revision of former
section 01115 - Green Building Requirements, which has been withdrawn.  The intention of
the new section is the same — to inform the Contractor about LEED Certification and draw
his attention to specific sections of the Project Manual that address LEED credits.  The
LEED-related  specification sections are listed in Masterformat 2004 section number order —
as opposed to LEED credit order in the LEED Credit Summary section.  When the Credit
Summary section is prepared first, it will activate all the relevant sections in the LEED
Requirements section.

Although the Credit Summary is explicitly intended for making a summary document early in
the project, the LEED Requirements section can also be used to “build” the Summary
document, by means of links from the section number ordered list back to the credit number
ordered list.  This will be especially useful where the same specification section addresses
issues that arise under different credits — all the credits relevant to a particular section are
grouped under the section listing.  Reviewing the list of relevant sections in both section
number order and credit order will give the most complete picture.

These SpecLink specification sections are based on the LEED-NC Version 2.1, Green
Building Rating System, by the U.S. Green Building Council.  Intelligent use of these
sections requires familiarity with the Rating System document which can be obtained free of
charge at www.usgbc.org.  The LEED Reference Guide would also be of considerable
assistance to designers and specifiers.

See “Hyperlinking” on page 3
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Svigals + PSvigals + PSvigals + PSvigals + PSvigals + Partners Brings Specificaartners Brings Specificaartners Brings Specificaartners Brings Specificaartners Brings Specificationtiontiontiontion
Writing In-House with BSD SpecLinkWriting In-House with BSD SpecLinkWriting In-House with BSD SpecLinkWriting In-House with BSD SpecLinkWriting In-House with BSD SpecLink

Based in New Haven, Connecticut and licensed in New York, Massachusetts, New Jersey,
and Maryland, Svigals + Partners has served over 200 clients throughout New England.

With a staff of 25, Svigals +
Partners provides personal-
ized service and attention to
every project.

The Need: Svigals’ personal-
ized attention to each project
is a key component to their
success. However, when they
looked at their specification
writing process, they saw that
it consisted of master text
provided by a local specifica-

tion consultant, combined with basic word processing. They decided they needed to bring
this entire process in-house, so that they would have better control and coordination of
their documents. Using BSD’s SpecLink would allow them to give the same level of atten-
tion to the specification process that they give to creating the design.

The Solution: Robert Skolozdra, Associate with Svigals, says, “We no longer hire consult-
ants to write our specs. We also spend less time during construction reviewing shop
drawings trying to figure out what the spec consultant was looking for. We can easily copy
and modify similar project types.” By creating a SpecLink Office Master, Svigals has been
able to bring all their spec writing in-house and completely automate and simplify their
process, while saving significant outsourcing costs per project.

They also found that with their “old” system, they were not updating their reference
standards or manufacturers information. Once they deleted text, it was gone – instead of
being preserved in a master file. “With SpecLink you always have the master data at your
fingertips. You are always working with updated standards,” says Skolozdra. This has
significantly increased their productivity in all areas. He continues, “SpecLink formats, links,
and generates the table of contents so we can focus on building the technical sections.”

Asked what he liked best about SpecLink, Skolozdra states, “Office and client master data
can be added so that the document is seamless. Plus, SpecLink is very compatible with
other word processing software. You can cut and paste, import and export as needed. Then
SpecLink formats everything, including line space, line numbering, and paragraph formats
automatically. It also generates page numbering and table of contents automatically. This
creates a professional looking document every time you print it.”

The Outcome: It took the associates at Svigals just a few days to understand the basics and
begin using SpecLink. Skolozdra says that the assistance provided by BSD’s technical
support department has been great. They have now used SpecLink on over 50 projects.
Because of the way SpecLink’s database is set up, they are able to keep lists of both name-
specific and non-proprietary items in their data file. This data handling ability is just one of
the unique SpecLink features Svigals uses every day to create better specifications.

CostLink/AE MakesCostLink/AE MakesCostLink/AE MakesCostLink/AE MakesCostLink/AE Makes
EstimaEstimaEstimaEstimaEstimating Easyting Easyting Easyting Easyting Easy

A CostLink/AE subscription includes one of
the largest collections of building construc-
tion cost data found anywhere and is
updated annually by R.S. Means, the
leading authority on this type of data. There
are nearly 22,000 line items of cost data in
the cost details database, providing costs
on everything from access doors to zinc
flashing. There are over 11,000 pre-con-
structed assemblies of line items ranging
from acoustical ceilings to wet pipe sprinkler
systems. And there are 73 building cost
models that give you a head start on
concept and detail estimates alike for
everything from apartment buildings to
warehouses.

Line item detail is organized by CSI division
and subdivision while assemblies are
organized by Uniformat II systems and
subsystems. It’s all searchable from one end
to the other using a few letters, a whole
word, or a phrase to search for the start or
any part of the description or R.S. Means
tag. Building types are categorized as
commercial, industrial or institutional and
each includes six distinct options for
structural system and exterior closure
system combinations.

Using a building type model is an excellent
way to get a conceptual cost and get started
on a detailed estimate. All you need to do is
select the building type, the structure and
closure option, enter the estimated gross SF
of construction along with an estimated
length of building perimeter and click apply.
You can even start with the default set of
values that is provided with each building
type. This will generate, for example, a cost
estimate for a 3 story office building that
includes 57 assemblies comprising some
280+ line items. And you can add to this, or
delete from it at will, using drag and drop.
You can choose from R.S. Means cost
adjustment factors for some 700 U.S. and
Canadian cities and add your own markups
or use the defaults.

CostLink/AE is easy to use and the data is
unparalleled. It takes less than 5 minutes to

See “CostLink” on page 3

NEW LEED NEW LEED NEW LEED NEW LEED NEW LEED TTTTTAAAAAG G G G G AND REPORAND REPORAND REPORAND REPORAND REPORTTTTT

To facilitate LEED documentation, a new tag for LEED submittals has been added.  Pull
down the tag list and select LR - LEED Report to tag any paragraph.  It is not possible to
put 2 tags on a paragraph, so if you need a provision on the LEED report as well as on a
normal submittals report, make a new paragraph to tag for the LEED report.  All sections
with LR-tagged paragraphs will appear on the report printed from the File Menu Print
dialog.



BSD LinkLine Summer 2005 3

PerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance SpecsPerSpective Performance Specs
StStStStStaaaaatistics:tistics:tistics:tistics:tistics:

• 161 sections, 6 updated (4%)
• 17,371 paragraphs
• 21,681 internal links (targets and

consequences)
• 3,291 notes to specifier
• 186 external documents referenced, 22%

verified as unchanged or reapproved
• 1 document never before referenced
• 2 obsolete documents replaced
• 38 standards organizations referenced

SpecLink+ StSpecLink+ StSpecLink+ StSpecLink+ StSpecLink+ Staaaaatistics:tistics:tistics:tistics:tistics:
• 657 sections total, 173 updated or new

(26%)
• 4 new non-proprietary sections, 2 with

checklists
• 506 non-proprietary sections, 142

updated or new (28%)
• 151 proprietary sections, 31 updated

(20%)
• 22 sections with built-in checklists
• 105,459 paragraphs
• 113,014 internal links (targets and

consequences)
• 17,824 notes to specifier
• 3,310 notes with live hyperlinks to

Internet web pages
• 2,109 external documents referenced,

16% verified as unchanged or
reapproved

About Your SpecLink & PerSpective Updates

Short FShort FShort FShort FShort Form Specs Storm Specs Storm Specs Storm Specs Storm Specs Staaaaatistics:tistics:tistics:tistics:tistics:

• 16 sections corresponding to
MasterFormat 1995 divisions

• 8,300 paragraphs
• 817 notes to specifier
• 8,772 internal links (targets and

consequences)

• 365 external documents referenced, 4%
verified as unchanged

• 1 obsolete document replaced
• 44 standards organizations referenced

• 17 documents never before referenced
• 34 obsolete documents replaced or

removed
• 184 standards organizations referenced
• 2 new standards organizations
• 2,284 manufacturer listings, with live

hyperlinks to their webs sites
• 905 unique manufacturers listed in 355

non-proprietary sections
• 7 manufacturers out of business or sold

people will be using your master project file, the root directory path
must be one that all users can follow; otherwise they will not be able
to open the linked documents. To establish the root directory path
for Word documents that will be linked to your office master project,
follow these steps:

1. Using Windows Explorer, create the folder where all hyperlinked
documents will be stored. For simplicity, we suggest you
establish a subfolder under your SpecLink folder.

2. In SpecLink, close all projects, then from the File menu, click on
Permissions. When the dialog box opens, click on the System
Settings tab.

3. The last setting on the System Settings tab is Root Directory
Path for Linked Documents. Click on the browse icon for that
setting and find the folder you created in Step 1. Click OK, and
the root directory path should appear in the setting.

4. Click on Apply and OK.
5. Using Windows Explorer or Word, place each document that

will be linked to the master project file in the folder you created
under Step 1 before you create a hyperlink to that document.

After you have established the Root Directory, use the following
steps to create a hyperlink that will automatically open a Word
document from SpecLink:

“Hyperlinking” continued from page 1

1. Be sure the Word document you want to link to has been
placed in your linked documents folder.

2. In your project, open to the appropriate section and scroll to
the paragraph where you want the hyperlink.

3. If the Document Link (DL) status column is not visible, on the
View menu, click on Display Layout and then on Document
Links. The DL column opens.

4. Open Windows Explorer and find the document to which you
want a link. Click on the document and hold the left mouse
button down, then drag the icon from Explorer and drop it in the
DL column at your source paragraph. The link is created and a
Word icon appears.

If you point to an icon without clicking, a balloon will appear with
the file name of the linked document. Subsequently, all you have to
do to activate the hyperlink is to click once on the Word icon in the
DL column. If Word is closed, clicking once on the icon opens Word
and then opens the hyperlinked document. There are a couple of
additional things you need to know about this feature: 1) each user
who will need access to the linked documents must establish the
root directory path in the Permissions dialog box; 2) to remove a
hyperlink, locate the paragraph that has the hyperlink you want to
remove and click anywhere within the paragraph. From the Docu-
ment menu, choose Remove Document Hyperlink.

Embedding context-sensitive hyperlinks to Word documents can
make your office master project a much more powerful tool, extend-
ing your corporate memory to all SpecLink users in your firm. If you
were unfamiliar with this built-in hyperlinking capability, we suggest
you try it out to see how easy it is to implement.

go through the modeling process and it provides a substantial
foundation for building a more detailed cost estimate. The subscrip-
tion costs less than you may think and discounts are available. Call
us today for a web-based demonstration or visit our website at
www.bsdsoftlink.com for more information.

“CostLink” continued from page 2
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01 3514 ( ( ( ( (01354) BSD - LEED Credit Summary) BSD - LEED Credit Summary) BSD - LEED Credit Summary) BSD - LEED Credit Summary) BSD - LEED Credit Summary:::::

See article on page 1.

01 3515 (01355) BSD - LEED Requirements: (01355) BSD - LEED Requirements: (01355) BSD - LEED Requirements: (01355) BSD - LEED Requirements: (01355) BSD - LEED Requirements:

See article on page 1.

05 7500 BSD Decora BSD Decora BSD Decora BSD Decora BSD Decorative Ftive Ftive Ftive Ftive Formed Metormed Metormed Metormed Metormed Metal - (al - (al - (al - (al - (05730
BSD - OrnBSD - OrnBSD - OrnBSD - OrnBSD - Ornamentamentamentamentamental Fal Fal Fal Fal Formed Metormed Metormed Metormed Metormed Metal):al):al):al):al):

This section can be used to specify a variety of custom interior
fabrications, such as column covers, wall cladding, HVAC housings,
etc. Metal composite material, made of two skins with a solid core, is
preferred by architects over plain sheet metal because it is super-
flat. In this section, the term “metal composite material (MCM)
sheet” is used for the flat sheet, in preference to ACM (aluminum
composite material) because metals other than aluminum are
increasingly being used. The term “panel” is reserved for the formed
panel made of MCM. The sheet manufacturers listed are Alcoa
(Reynobond), Alcan (Alucobond) and Mitsubishi (Alpolic). Other
types of decorative formed metal fabrications can be added to this
section by editing.

07 4264 ( ( ( ( (07431) BSD - Met) BSD - Met) BSD - Met) BSD - Met) BSD - Metal Composite Maal Composite Maal Composite Maal Composite Maal Composite Materialterialterialterialterial
WWWWWall Pall Pall Pall Pall Panels:anels:anels:anels:anels:

Metal composite material, made of two skins with a solid core, is
preferred by architects over plain sheet metal because it is super-
flat. In this section, the term “metal composite material (MCM)
sheet” is used for the flat sheet, in preference to ACM (aluminum
composite material) because metals other than aluminum are
increasingly being used. The term “panel” is reserved for the formed
panel made of MCM. The fabricators who make panels and wall
systems out of MCM are referred to as “wall system manufactur-
ers,” primarily because to achieve the specified performance criteria
standard, tested systems must be used — even though they are
custom-built, they are pre-engineered and tested. This section can
be used to specify high-performance curtain wall, rainscreen curtain
wall, and cladding applied to a solid substrate. An optional checklist
helps determine which performance criteria and tests are appropri-
ate. MCM sheet manufacturers listed are Alcoa (Reyno-bond),
Alcan (Alucobond) and Mitsubishi (Alpolic). Fabricator names are
not listed, as they tend to be local and regional.

32 1413 BSD - Precast Concrete Unit PBSD - Precast Concrete Unit PBSD - Precast Concrete Unit PBSD - Precast Concrete Unit PBSD - Precast Concrete Unit Paaaaavingvingvingvingving
(((((02783 BSD - Concrete P BSD - Concrete P BSD - Concrete P BSD - Concrete P BSD - Concrete Paaaaavers) [Revised]:vers) [Revised]:vers) [Revised]:vers) [Revised]:vers) [Revised]:

Open grid concrete pavers have been added to this section. These
are typically high strength, designed for intermittent vehicular traffic
with grass or other vegetation growing in the openings. Verify net
open area required for LEED SS Credit 7.1 (heat island effect, non-
roof), as that credit calls for minimum 50 percent open, which may
not be available from some manufacturers. Other LEED credits
would be based on calculations based on actual net open area.
Installation on sand bed is typical. Manufacturers listed are Belgard
Turfstone and Interlock Paving Systems Turfstone.

New SpecLink SectionsNew SpecLink SectionsNew SpecLink SectionsNew SpecLink SectionsNew SpecLink Sections

Figure 1

GETTING STGETTING STGETTING STGETTING STGETTING STARARARARARTEDTEDTEDTEDTED
WITH LEED WITH LEED WITH LEED WITH LEED WITH LEED AND SPECSAND SPECSAND SPECSAND SPECSAND SPECS

SpecLink Section 01 3514 (01354) - LEED CREDIT SUMMARY
includes a feature specifically designed for specifiers new to LEED
— an OPTIONAL CHECKLIST that organizes the credits in groups
based on their importance and ease of achievement, not simply
similar issues as the Rating System does.  For instance, there are 7
PREREQUISITES, without which LEED Certification is impossible.  If
you check off the Prerequisites group and scroll down through the
Credit list, the Prerequisites are highlighted for easy identification.
Pre-defined solutions taken directly from the Rating System
document are shown for each Prerequisite — 3 of the 7 are com-
pletely addressable via the specifications, 2 must be addressed by
the design, and 2 are partly addressable by the specifications.
Figure 1 shows an example of a Prerequisite and its pre-defined
solutions.

Following the Prerequisites are 69 credits, of which at least 26 must
be addressed to achieve minimum Certification.  To simplify the
process of deciding which to pursue, 8 groups are presented.
Figure 2, on the next page, is a partial view of the checklist groups.

• Site Location Options — these are easy to rule out or in, since
whether they are achievable or not depends on the actual
project site.

• Construction Procedures — these are easy to specify since
they are made entirely the Contractor’s responsibility (this is
not to say that they won’t cost more, just that they are easy to
specify).  These include construction waste management and
IAQ procedures.

Continued on next page
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Figure 2

LinkLine

A BSD SoftLink® Publication

Editor: Niki Koplowitz

The LinkLine is published by
Building Systems Design, Inc.
3520 Piedmont Road, NE
Suite 415
Atlanta, GA 30305

Permission to use excerpts in
other publications is granted
provided the publisher is notified
in advance at 404-365-8900.

BSD SpecLink, BSD CostLink
and BSD SoftLink are registered
trademarks, and BSD CadLink
and BSD LinkMan are all
trademarks of Building Systems
Design, Inc.

Get the latest on BSD by visiting
our web page at
www.bsdsoftlink.com

See “Specifying ‘Green’ ” on page 7

• No- and Low-Cost “Good Sense” Options — these credits
probably won’t cost much to achieve and would be sensible in
most non-residential buildings.  They include site design, water
efficient landscaping, light colored roof and paving, light
pollution prevention, low-emitting materials such as carpet,
paint, and adhesives, prohibiting formaldehyde containing
wood materials, etc.  Some are addressable via the
specifications, some are not.

• Architectural Design
Options — these credits
require a specific architectural
design, which may be different
than normally anticipated.
Examples are provision of
daylighting and views,
isolation of indoor chemical
and copy rooms, etc.
• Plumbing Design —
water-saving options, several
of which involve the use of
rainwater and/or graywater
systems. This checklist option
allows you to choose
rainwater, graywater, or none
as a project-wide solution.
The designs are  not directly
addressable via the
specifications, although
something must be specified
to achieve them.

• HVAC Design — enhanced HVAC design and/or extra
systems that are not commonly encountered.  Most of
these are not directly addressable via the specifications,
although something must be specified to achieve them.
Most involve increased energy efficiency or alternative
energy sources.

• Electrical Design — enhanced lighting design and/or
systems that are not commonly encountered, such as more
individual controls than usual.

• “Green” Products Issues — recycled content, rapidly
renewable content, locally-manufactured products, re-used
products, and “certified” wood.  These are grouped
together because achieving the credit requires
documentation of the percentage of all materials on the
project that is in each category, by cost.  The
documentation requirements are specified in Sections 01
3515 (01355) LEED REQUIREMENTS and 01 6000 (01600)
PRODUCT REQUIREMENTS.  This group of credits is last
in this list because the record keeping during the
construction phase is likely to be a significant cost of each
credit, independent of any material cost increase.  Except
for certified wood, it is very unlikely that the Contractor
can assume responsibility for achieving any of these
credits.  The specifier will need to determine which
products can meet the criteria, specify them, and then
require the Contractor to submit the documentation
required.  Specifying the documentation is pretty easy,
using SpecLink — specifying the products is the hard part.
Another reason this group is last is that even though
“green” materials has a high profile as a general “green”
issue, the LEED Rating System assigns only 8 credits to
the 5 issues.  Since Platinum Certification requires only 52
of 69 credits, Platinum Certification is achievable without
addressing any of these credits at all!  Considering the
difficulty of specifying and documenting, these credits
should be the last to be considered, unless there are other
reasons to do so.

SPECIFYING “GREEN”SPECIFYING “GREEN”SPECIFYING “GREEN”SPECIFYING “GREEN”SPECIFYING “GREEN”
WITHOUTWITHOUTWITHOUTWITHOUTWITHOUT LEED LEED LEED LEED LEED

SpecLink’s “green” provisions are not exclusively for LEED
Certification.  In fact, all “green” provisions are stated without LEED
language to make them useful for any project whether or not LEED
Certification is needed.  In most cases, the green provisions are
simply additional specifier options that may or may not apply to the
project.  The green provisions are also more “universal” because
they are not collected into a single “LEED” section — the relevant
provisions are located in each applicable specification section,
where they can address the issue independently of LEED.  For
example, Section 01 5721 - Indoor Air Quality Controls (01734 -
Indoor Air Quality), includes provisions to achieve LEED EA
Prerequisite 2 (testing dedicated smoking rooms), EA Credit 2

○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○
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All ProductsAll ProductsAll ProductsAll ProductsAll Products

Does your website have any place to
search for information about use of

your products or learn more about an error
code, for example?

We are working on a knowledge base
for our users. To view the initial

setup and to offer suggestions, go to
www.bsdsoftlink.com/support_qa.

Our company has a Citrix server that
people run software from when they

are traveling. Can we run BSD software this
way?

Yes. On the Citrix server perform a
Standalone installation of SpecLink,

CostLink/AE, or CostLink/CM. You will need
to get an Access Key for the server - call
BSD Technical Support (800-266-7732) to
discuss your options and to see if you will
need to buy a key for the server, or if you
have a license that you can move to the
server at no cost. Once the software is
installed and has a key, employees at your
company will be able to run BSD software
from the Citrix server when they are traveling
in the same way as they run other applica-
tions. No installation will be required on the
computers from which the users are dialing
in.

SpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpectiveSpecLink+ and PerSpective

Is there any way to include a degree
symbol or other special characters in

my specification?

You can copy and paste symbols
from Windows Character Map. The

Character Map can usually be opened by
choosing Start | Programs | Accessories |
System Tools | Character Map, but is located
in different places in different versions of
Windows. If you cannot locate the character
map, open Windows Explorer and search the

Help topics or do a search for charmap.exe.
Once you open the Character Map, choose
the font you are using in SpecLink from the
Font list, and scroll through all the charac-
ters until you find the one you need. Click
on Select and then Copy to copy it to the
Windows clipboard. From there you can
paste it into SpecLink.

Is there any way to reference Word
documents that are on our file server

from within our office master, so that all of
our spec writers can access them while they
are in the software?

The easiest way is to store all of
these Word documents on a server

to which all users have access. You will
need to establish the Root Directory path in
the Permissions, Systems Settings dialog
box.  Use the following steps to create a
hyperlink that will automatically open a
Word document: Be sure the Word docu-
ment you want to link to is in your linked
documents folder. In your project, open to
the appropriate section and scroll to the
paragraph where you want the hyperlink. If
the Document Link (DL) status column is
not visible, on the View menu, click on
Display Layout and then on Document
Links. The DL column opens. Open Win-
dows Explorer and find the document to
which you want a link. Click on the docu-
ment and hold the left mouse button down,
then drag the icon from Explorer and drop it
in the DL column at your source paragraph.
The link is created and a Word icon appears.
If you point to an icon without clicking, a
balloon will appear with the file name of the
linked document. Subsequently, all you
have to do to activate the hyperlink is to
click once on the Word icon. If Word is
closed, clicking once on the icon opens
Word and then opens the linked document.

How do I create links from my Short
Form specs to SpecLink sections?

Creating links between sections is
the exact same process as adding

links between paragraphs. The only
difference is that you need to have two
windows open, one for each section.  With
one section open, click on Window | New
Window.  In the new window, click in the

second section you want to work with (it
can be in the same tab or in a different tab).
It may be easier to close the Project Tree
panel in both windows, so that you can see
as much of the Document Panel as possible.
To see both windows at the same time, click
on Tile Vertically or Tile Horizontally under
the Window menu. Remember, when two
sections are open, one is always the
“current” window; the title bar is a different
color. You can switch back and forth
between them and as long as you don’t click
in any text cell the cursor positions stay the
same in each.  Create links as normal when
adding links between paragraphs. You may
want to click on the Lock checkbox in the
Links dialog box when dragging links from
one section to another.  You may also want
to temporarily turn off In-Memory Linking
on the Tools menu so that the links between
sections will be implemented as soon as you
create them.  See the question for instruc-
tions on creating links.

I printed my manufacturing listing
report but it doesn’t include the

manufacturers I have added. Can I get them
on this report?

Paragraphs have to be tagged to
appear on the various reports.  You

can add Tags to any paragraph. If the Tag
(T) status column is not visible, on the View
menu, click on Display Layout and then on
Tags.  Click in the paragraph that needs the
tag, and from the Tags dropdown list on the
formatting toolbar above the Document
Panel, choose the appropriate tag (ML for
Manufacturing Listing). When the para-
graph with the tag is active and you print
the report for the tag, the section will be
listed in the report. For a list of Tags and
their functions, search Help for Tags.

Is there away to add our own custom
tags to master tags list?  I’d like to be

able to print reports indicating sections with
LEED’s submittal requirements for a concise
list of project LEEDs elements.

We don’t yet have a way to add your
own tags, but the Summer 2005

release includes a new tag (LR) and LEED
report. See box on page 2.

Continued on next page
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“Specifying ‘Green’ ” continued from page 5

How do I create links between
paragraphs?

More questions?
Contact BSD Technical Support:

Toll Free: 800-266-7732
In Atlanta: 404-365-9226

Email: support@bsdsoftlink.com

the option ‘Auto-Recalculate Markups.’ If
there is a checkmark, click on the option to
turn it off. When this option is turned on,
CostLink/CM completely recalculates a new
grand total for your estimate every time you
make an edit. Another way to speed up the
process is to create a new Labor Library and
edit the labor rates there instead of in your
estimate. When the library is finished,
reprice the estimate to the new rates in the
library.

I have copied a number of tasks from
my CostBook into my Project and

now I want to change the material costs.
How do I do that?

To change the costs in a task, you
need to go to the appropriate

resource view for that cost.  To change the
material cost, go to the Unassigned folder in
the CSI Resource View, and open the Item
Form for the task you want to change.  You
can change the material cost here, as well as
the Production Rate for this task.  This is
also where you can change the crew
assigned to this task.  Go to the Labor
Resource View to change the hourly rate for
a particular laborer.

(verification of ventilation effectiveness),
and EA Credits 3.1 and 3.2 (construction air
quality precautions and procedures),
without mentioning LEED at all!  Any or all
of those procedures would be just as
relevant on projects not requiring LEED
certification.

An easy way to identify sections that
address “green” issues is to review Section
01 3515 (01355) LEED REQUIREMENTS.
Although its list of specification sections
is intended for the Contractor’s informa-
tion, it also serves as a checklist for the
specifier.  Here’s a list of SpecLink sections
that address major environmental responsi-
bility issues independently of LEED:

01 5713 (01575) - Temporary Erosion and
Sedimentation Control (prevention,
remediation)

01 5721 (01734) - Indoor Air Quality
Controls (during construction and prior to
occupancy)

01 6000 (01600) - Product Requirements
(project-wide material requirements and
prohibitions)

01 7000 (01700) - Execution and Closeout
Requirements (site drainage, pollution
prevention)

01 7419 (01732) - Construction Waste
Management and Disposal (landfill diver-
sion)

01 9113 (01810) - General Commissioning
Requirements (functional testing by
Contractor)**

01 9114 (01815) - Commissioning Authority
Responsibilities (independent agency)**

02 6500 (02115) - Underground Storage
Tank Removal (petroleum)

02 8400 (13284) - Polychlorinate Biphenyl
(PCB) Remediation (and mercury lamps)

06 1000 (06100) - Rough Carpentry (and
other Division 6 sections) (prohibition on
old growth timber, sustainably harvested
wood, salvaged and re-used wood)

07 9005 (07900) - Joint Sealers (VOC limits
prescribed by law and LEED)

09 6800 (09680) - Carpeting and 09 6850
(09685) - Carpet Tile (low emitting materials)

09 9000 (09900) - Painting and Coating
(VOC limits prescribed by law and LEED)

23 0800 (15102) - Commissioning of HVAC
(Contractor’s duties specific to HVAC)

31 1000 (02230) - Site Clearing (limits on
site disturbance)

32 1413 (02783) - Precast Concrete Unit
Paving (open-grid pavers for pervious
surfacing)

** See our LinkLine Spring 2005 issue for
“Specifying Commissioning Using
SpecLink,” which while relevant to LEED, is
critical to proper functioning of virtually any
type of building project.

To make a link from one paragraph to
another:

• In the Document Panel, position the
cursor on the paragraph that is to be the
link source. Open the Links Window by
clicking on the Links icon on the Toolbar,
or choose View > Links.
• Click on the Target Links tab.
• Scroll the Document panel to show
the paragraph that is to be the link target.
NOTE: Do NOT move the cursor off the
link source. Use the scroll bar and don’t
click in any other text cell.  The target can
be anywhere in the project, including a
different section (see above).
• When the target paragraph is visible,
using the mouse, position the cursor over
the status columns to the left of the text,
hold down the right mouse button, and
start to drag with the mouse. The cursor
arrow changes to a circle and bar symbol.
Continuing to hold the right mouse button
down, drag the cursor to any position
within the upper window in the Target
Links tab of the Links Window, and release
the mouse button. (Note: If you are not
able to create a link, be sure that you are
dropping it into the Target Links tab. You
may also need to drag more slowly when
dragging the link.)
• To change the type of link, double-
click on the green arrow. It toggles to red.
Another double-click toggles it to yellow.
• The link is built automatically and
appears in the Target Links listing.
NOTE: User-added links appear with
underlining, to differentiate them from
master links.
• If the parent of the target paragraph is
active, the new link will be activated
immediately and will appear in bold font in
the Links Window.

CostLink/CMCostLink/CMCostLink/CMCostLink/CMCostLink/CM

I am changing the labor rates in the
resource view of my estimate, and it

is going very slowly. Is there anything I can
do to speed this up?

The first thing to check is to go to a
Primary view, and in the Tools menu

check to see if there is a checkmark next to
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The BSD SpecLink+ Workshop consists of
two one-day workshops.  The first day is
devoted to learning the basics of
SpecLink+, including how to navigate
within the software, start a new project, edit
sections, understand how the links and
choices work, and how to format, print and
export the final document.  It is designed
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